
 

Manual Smart view

Smart view 
Software-Version: 4.60
DOK-HB-SMARTVE
Revision: C
English



Table of Contents

Table of Contents

Table of Contents.............................................................................................................................................. 2
Smart View........................................................................................................................................................ 3
Installation of Smart View........................................................................................................................................ 4
Silent Installation..................................................................................................................................................... 5
Uninstalling Smart view........................................................................................................................................... 5
Switching the Language of the Graphical User Interface.........................................................................................5
Setting up the Connection PC - Device...................................................................................................................6
Loading of Device Data when using Smart view ...................................................................................................14
Restoring of Device Data when using Smart view.................................................................................................15
Backup and Documentation when using Smart view.............................................................................................16
Offline Device Planning via Smart view................................................................................................................. 17
Smart view Keyboard Commands......................................................................................................................... 18
Measuring Values.................................................................................................................................................. 19
Acknowledgments................................................................................................................................................. 20
Status Display ....................................................................................................................................................... 21
Recorder................................................................................................................................................................ 22
Parameters............................................................................................................................................................ 27
Device Parameters................................................................................................................................................ 34
Display of ANSI-Codes.......................................................................................................................................... 36
Graphical Display of Tripping Characteristics........................................................................................................36
Programmable Logic............................................................................................................................................. 39
IEC61850*............................................................................................................................................................. 40
Remote Configuration for Line Differential Protection Devices*.............................................................................42

2 Smart view DOK-HB-SMARTVE



Smart View

Smart View
Smart view is a parameter setting and evaluation software.

It is primarily intended to be connected with devices from the HighPROTEC family of protection devices, and 
therefore this is the main focus of this manual, especially because the devices from this series offer the most 
complexity and feature-richness.  However, there are also a lot of protection devices from the High Tech Line 3, the 
Professional Line and the WI Line series supported.  Woodward will continue to add support for more and more 
devices (plus – of course – further enhancements in general); therefore it is worthwhile making sure to always have 
the latest Smart view version installed.

However, please be aware that for devices from the High Tech Line 3, the Professional Line and the WI Line 
series, not all functionality described in this manual is available; only those features can be used that are actually 
supported by the connected device.

The full feature set, as available with HighPROTEC devices, comprises:

Menu-controlled parameter setting incl. validity checks
Offline configuration of all relay types
Reading and evaluating of statistical data and measuring values
Setting into operation assistance
Display of the device status
Fault analysis via event- and fault recorder

Smart view 3.0 or higher supports reading parameter files generated by older 
versions of Smart view. Parameter files generated by Smart view 3.0 and 
higher cannot be read by older versions of Smart view. 
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Smart View

Installation of Smart View

Port 52152 must not be blocked by a Firewall

If the Windows User Access Control pops up while installing Smart view, please 
“Allow” all installation requirements concerning Smart view.

System requirements:

Windows 7, Windows 8.x or Windows 10

To install Smart view:

Double-click on the installation file with the left mouse button.

Select a language for the installation procedure. 

Confirm by pressing the »Continue« button in the INFO frame.

Select an installation path or confirm the standard installation path by mouse click on the »Continue« button.

Confirm the entry for the suggested installation folder by mouse click on the »Continue« button.

By mouse click on the »Install« button, the installation routine is started.

Close the installation procedure by mouse click on the »Complete« button.

Now you can call up the program via [Start>Programs>Woodward>Smart view]. 
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Smart View

Silent Installation

In some cases it is required to perform an unattended (“silent”) installation. For example, an IT department might 
want to remotely install or upgrade Smart view without the PC user being distracted by dialog windows.

The setup program features a special “silent” mode for this purpose, which is entered if command-line options are 
given as follows:

• Smartview_SE_Install.exe  /SILENT
This command performs a “silent” installation of all Smart view-related applications including USB driver, 
and there is no user interaction needed for the installation process. However, the Installation Progress win-
dow is visible during the installation process.

• Smartview_SE_Install.exe  /VERYSILENT
This command performs a “very silent” installation of all Smart view-related applications including USB 
driver: There is no user interaction needed for the installation process, and no dialog or window is visible.

The SILENT and VERYSILENT options may be command with another option, UNINSTOLD.

• Smartview_SE_Install.exe  /SILENT  /UNINSTOLD
Smartview_SE_Install.exe  /VERYSILENT  /UNINSTOLD
In addition to the “silent” and “very silent” installation described above, it is checked whether there are any 
previous (“old”) versions of Smart view installed, and if this is the case then the previous version(s) are un-
installed (also in a “silent” manner, without any user interaction).

Note that additional preparations might be necessary to let the installation pro-
cess run seamlessly; in particular, the “UAC” (User Access Control) dialog of 
the Windows operating system has to be managed via the “Microsoft System 
Center” and the “Microsoft Group Policy”.

Uninstalling Smart view

Via the menu [Start>System Control >Software] the Smart view can be removed from your computer.

Switching the Language of the Graphical User Interface

Within the menu Settings/Language, you can change the language of the graphical user interface.
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Smart View

Setting up the Connection PC - Device

Set up a Connection via a Serial Interface

Parameter Setting and Evaluation via Serial/RS232

After installation of the software, the »Connection PC/Notebook to the Device« has to be configured once so that 
you are able to read device data or re-write them into the device by means of the software Smart view. 

For connection of your PCs/notebooks with the device, you need a zero-
modem (COMRS232Nullm) cable (no serial cable!/please refer to chapter 
»Zero Modem Cable«). Please refer to the corresponding chapter within the 
device manual.

If your PC/notebook does not have a serial interface, you need a special »USB-
to-serial-adapter«. Only if the »USB-to-serial-adapter« (USB2RS232ADAP) is 
correctly installed - aided by the provided CD – the communication with the 
device can be established. (see next chapter).

Parameter Setting and Evaluation via Serial/RS232 and USB to Serial Adapter (for notebooks without RS232  
interface)
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Smart View

Setting up/Configuring the connection 

Connect your PC/notebook with the device via a zero-modem cable. 

Start the software Smart view.

Select the menu point »Device Connection« in menu »Settings«. 

Click on »Serial Connection«.

Click button »Settings«.

Select the serial interface (COM-Port) where the device shall be connected to. 

Confirm the adjustments by clicking the »OK« button. 

If the interface is chosen for the first time, a popup window will appear “The selected connection is currently 
not installed. Should this connection be used for device communication? “. Confirm this by pressing the 
“Yes” button.

Establishing the Connection via a USB-/RS232-Adapter

If your PC/notebook is not provided with a serial interface, this can be compensated by a special USB-/RS232-
Adapter+Zero Modem-Cable.

Only an adapter accepted by Woodward Kempen GmbH is to be used 
(USB2RS232ADAP). First install the adapter (with the related driver that you 
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Smart View

can find on the CD) and then establish the connection (Smart view => Device). 
The adapters must support very high speed.
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Smart View

Set up a Connection via Ethernet - TCP/IP

Warning: Mixing up IP-Addresses (In case that there is more than one 
protective device within the TCP/IP network). Establishing an unintentional 
wrong connection to a protective device based on a wrong entered IP-Address. 
Transferring parameters into a wrong protective device might lead to death, 
personal injury or damage of electrical equipment.

In order to prevent faulty connections the user has to document and maintain a 
list with the IP addresses of any switchboard/protective device.

The user has to doublecheck the IP addresses of the connection that is to be 
established. That means, the user must first read out the IP address at the HMI 
of the device (within menu [Device para/TCP IP/TCP/IP Config] then compare 
the IP address with the list. If the addresses are identical, establish the 
connection. If not, DO not connect.

Parameter Setting and Evaluation via TCP/IP

Establishing a connection via TCP/IP to the device is only possible if your 
device is equipped with an Ethernet Interface.

Contact your IT administrator in order to establish the network connection.
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Smart View

Part 1: Set the TCP/IP Parameters at the panel (Device).

Call up the »Device parameter/TCP/IP« menu at the HMI (panel) and set the following parameters:

TCP/IP address

Subnet mask

Gateway

Part 2: Setting the IP address within Smart view 

Call up the menu Settings/Device Connection within Smart view.

Select the button Ethernet-Connection.

Enter the IP-Address of the device that should be connected.
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Smart View

Setting up the connection via a USB Cable

Parameter setting and evaluation via USB cable.

Please install Smart view in case that it has not yet been installed on your PC. 

Connect your PC/notebook via a USB cable with a powered/running device.

Start the software Smart view.

Select the menu point »Device Connection« in menu »Settings«. 

Within this menu select the communication option USB connection.

Within the Drop-Down-Menu select the connected USB device.

If the interface is chosen for the first time, a pop-up window will appear “The selected connection is currently  
not installed. Should this connection be used for device communication? “. Confirm this by pressing the  
“Yes” button.
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Smart View

Smart view Troubleshooting during Setting up the Connection

Make sure whether the Windows service Telephony is started. In [Start>System Control >Administration 
>Services] the service »Telephony« must be visible and must have also been started. If not, the service has 
to be started. 

For establishing the connection, you need to have sufficient rights (administration rights). 

If a firewall is installed on your computer, TCP/IP port 52152 must have been released. 

If your computer is not provided with a serial interface, you need a USB-to-serial-adapter, accepted by 
Woodward Kempen GmbH. This adapter has to be properly installed.

Ensure that a zero-modem cable is used (a standard serial cable without control wires does not enable 
communication).
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Smart View

Smart view persistent connection problems*

*=applies to serial connections only (RS232)

In case of persistent connection problems you should remove all connection settings and establish them again af-
terwards. In order to remove all connection settings please proceed as follows:

1. Remove the settings for the Dial-up Network

Close Smart view

Call up the »Control Panel«

Choose »Network & Internet«

On the left side click on »Manage Network Connections«

Click on HighPROTEC Direct Connection with the right hand mouse key

Choose Delete from the shortcut menu

Click on the OK button

2. Remove the virtual modem

Call up the »Control Panel«

Choose »Hardware & Sound«

Choose »Phone & Modem Options«

Go to Tab Modem

Click on the correct (in case there is more than one) entry Connection cable between two computers

Click on the Remove button
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Smart View

Connected to the Device and Calling up Websites at the same Time*

*=applies to serial connections only (RS232)

In principle, it is possible to call up websites while there is an active connection to the device.

If your computer has no direct connection to the internet, that means, that it is placed behind a proxy server, the 
device connection has to be modified in certain circumstances. The device connection has to be provided with the 
proxy settings.

Example: Internet Explorer

For each connection the proxy settings have to be set manually. Please proceed as follows:

Start your Internet Explorer.

Call up the »Tools« menu.

Call up the menu »Internet options«.

Call up the tab »Connections«.

Click with the left hand mouse key on the button »Settings« on the right of the »HighPROTEC Direct 
Connection«.

Set the check box »Use Proxy Server for this connection. 

Enter the proxy settings that are available by your network administrator.

Confirm the settings by pressing »OK«.

Firefox

The proxy settings are centrally managed, so there is no need to modify any settings.

Loading of Device Data when using Smart view 

Starting of the Smart view.

Make sure the connection has been established properly. 

Connect your PC with the device.

Select »Receiving Data From The Device« in menu »Device«. 
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Smart View

Restoring of Device Data when using Smart view

Via the button »Transfer only modified parameters into the device« only 
modified parameters are transmitted into the device.

Parameter modifications are indicated by a red “star symbol” in front of the 
parameter.

The star symbol (in the device tree window) indicates that parameters in the 
opened file (within smart view) differ from parameters stored on your local hard 
disk.

Via the button »Transfer only modified parameters into the device«, you can 
transmit all parameters that are marked by this symbol.

If a parameter file is saved on your local hard drive, these parameters are no 
longer classified to be modified and cannot be transmitted via the button 
»Transfer only modified parameters into the device«.

In case that you have loaded and modified a parameter file from the device and 
saved it to your local hard drive without transferring the parameters into the 
device beforehand, you cannot use the button »Transfer only modified 
parameters into the device«. In a case like that, use »Transfer all parameters 
into the device«. 

The button »Transfer only modified parameters into the device« only works if 
modified parameters are available in the Smart view.

In contrast to that, all parameters of the device are transferred when the button 
»Transfer all parameters into the device« is pressed (provided all device 
parameters are valid).  

In order to (re-)transfer changed parameters into the device, please select »Transfer all parameters into the 
device« in menu »Device«. 

Confirm the safety inquiry »Shall the parameters be overwritten into the device?“«.

Enter the password for setting parameters in the popup window.

Thereafter the changed data is transferred to the device and adopted. 

Confirm the inquiry »Parameters successfully updated. It is recommended to save the parameters into a 
local file on your hard drive. Shall The Data Be Saved Locally?“« with »Yes« (recommended). Select a 
suitable folder on your hard disk. 

Confirm the chosen folder by clicking »Save«. 

The changed parameter data is now saved in the folder chosen by you. 
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Smart View

Backup and Documentation when using Smart view

How to save device data on a PC: 

Click on »Save as ...« in menu »File«. Specify a name, choose a folder on your hard disk and save the device data 
accordingly. 

Printing of Device Data When using Smart view (Setting List)

The »Printing menu« offers the following options:

Printer setting

Page preview

Printing 

Export the selected printing range into a txt-file.

The printing menu of the Smart view software offers contextual different types of printing ranges. 

Printing of the complete parameter tree:
All values and parameters of the present parameter file are printed. 

Printing of the displayed working window: 
Only the data shown on the relevant working window are printed, i.e. this applies, if at least one window is 
opened.

Printing of all opened working windows: 

The data shown on all windows are printed, i.e. this applies only if more than one window is opened. 

Printing of the device parameter tree as from a shown position on:
All data and parameters of the device parameter tree are printed as from the position/marking in the navigation 
window. Below this selection the complete name of the marking is additionally displayed. 

Saving Data as a txt-file via Smart view

Within the print menu [File>Print] you can choose »Export into File« in order to export the device data into a text-file.

Only the actual selected printing range will be exported into a text-file. That 
means: If you have chosen the “Complete device parameter tree” then the 
“Complete device parameter tree” will be exported. But, if you have chosen 
“Actual working window”, only this window will be exported.

You can print out operating data but not export them.

If you export a txt-file, the content of this file is encoded as Unicode. That 
means that, if you want to edit this file, your application must support Unicode 
encoded files (e.g. Microsoft Office 2003 or higher).
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Smart View

Offline Device Planning via Smart view

In order to be able to transmit a parameter file (e.g. offline created) into the 
device the following issues must comply:

Type Code (written on the top of the device/type label) and

Version of the device model (can be found in menu 
[Device Parameters\Version].

The Smart view software enables also to parameterize offline. The advantage is: By using device models you can 
do planning jobs for a device and set parameters in advance.  

You can also read the parameter file out of the device, further process it offline (e.g. from your office) and finally re-
transfer it to the device.

You can either:

load an existing parameter file from a device (please refer to chapter [Loading device data when using Smart 
view]). 

create a new parameter file (see below),

open a locally saved parameter file (backup).

In order to create a new device/parameter file by way of a device template offline:

In order to create a new offline parameter file please choose within the »file-menu« »create new parameter file«.

A working window pops up. Please make sure, that you select the right device type with the correct version and 
configuration.

Finally click on »Apply«

In order to save the device configuration select »Save« out of the »File-Menu«.

Within the menu »Modify Device Configuration (Typecode)« you can modify the device configuration or simply 
find out the type code of your current selection.

If you want to transfer the parameter file into a device, please refer to chapter “Restoring of device data when using 
Smart view”.
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Smart View

Smart view Keyboard Commands

You can control Smart view alternatively by means of keyboard commands (instead of the mouse)

Key Description

á Moving up within the navigation tree or parameter list.

â Moving down within the navigation tree or parameter list.

ß Collapse the tree item or select a folder on a higher level.

à Expands the tree item or selects a subfolder.

Numpad + Expands the tree item.

Numpad − Collapses the tree item.

Home Moves to the top of the active window.

End Moves to the bottom of the active window.

Ctrl+O Opens the file opening dialog. Browsing through the file system for an existing device 
file.

Ctrl+N Creates a new parameter file file by means of a template.

Ctrl+S Saves actual loaded parameter file.

F1 Displays the online help information.

F2 Load Device Data

F5 Reloads the displayed data of a device. 

Ctrl+F5 Enables automatic refresh.

Ctrl+Shift+T Back to the navigation window.

Ctrl+F6 Walks through the tabular forms (detail windows).

Page á Previous value (parameter setting).

Page â Next value (parameter setting).

Ctrl+Shift+Alt+S Switches on/off the service info mode, which displays additional service information.
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Smart View

Measuring Values

Read out of Measured Values via Smart view 

In case Smart view is not running – please start it.

If the device data were not yet loaded – select »Receive Data From The Device« from menu »Device«. 

Double click on icon »Operation« in the navigation tree. 

Double click on icon »Measured Values« within the navigation tree »Operation«. 

Double click the »Standard Values« or special values within the »Measured values«.

The measured and calculated values are shown now in tabular form on the window.

To have the measuring data read in a cyclic manner, select »Auto refresh« in 
menu »View«. The measured values are read out about every two seconds. 
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Smart View

Acknowledgments

Manual Acknowledgment via Smart view

In case Smart view is not running – please start it

If the device data were not yet loaded – select »Receive Data From The Device« from menu »Device« 

Double click on icon »Operation« in the navigation tree.

Double click on icon »Acknowledgment« within the operation menu.

Double click the entry within the popup that is to be acknowledged.

Press the button »Execute immediately«.

Confirm the question if the changes should be executed by »Yes«.

Enter your password.

External Acknowledge via Smart view

In case Smart view is not running – please start it.

If the device data were not yet loaded – select »Receive Data From The Device« from menu »Device« 

Double click on icon »Device Parameter« in the navigation tree

Double click on icon »Ex Acknowledge« within the operation menu

In the working window you can assign now each one signal that resets all acknowledgeable LEDs, a signal 
that resets all binary outputs, a signal that resets the SCADA-signals respectively a signal that 
acknowledges a pending trip command. 

Manual Resets via Smart view

In case Smart view is not running – please start it

If device data has not been loaded yet – click »Receive Data From The Device« in menu »Device« 

Double click the »Operation« icon in the navigation tree

Double click the »Reset icon« within the operation menu

Double click the entry within the popup that is to be reset or deleted.
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Smart View

Status Display 

Status Display via Smart View

In case Smart view is not running – please start it.

If the device data were not yet loaded – select »Receive Data From The Device« from menu »Device«. 

Double click on icon »Operation« in the navigation tree

Double click on icon »Status Display« within the operational data

Double click on a subfolder (e.g. Prot) in order to see e.g. the states of the general alarms.

To have the status display updated in a cyclic manner select »Automatic Up-
Date« in menu »VIEW«. 

State of the module input/signal is... Is shown in Smart view as...

 false / »0« 0

true / »1« 1

No connection to the device or busy ?
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Smart View

Recorder

Disturbance Recorder 

Disturbance Recorder to be Read Out by Smart view 

In case Smart view is not running – please start it.

If device data has not been loaded yet – click »Receive Data From The Device« in menu »Device«. 

Double click the »Operation« icon in the navigation tree.

Double click the »Recorders« icon in the navigation tree.

Double click the »Disturb rec-Icon«.

In the window the disturbance records are shown in tabular form.

A popup will be appear by a double click onto a disturbance record. Choose a folder where the  disturbance 
record is to be saved to.

You can analyze the disturbance records by means of the optionally available Data Visualizer by clicking on Yes 
when you are asked “Shall the received disturbance record be opened by the Data Visualizer?"

Deleting Disturbance Records via Smart view 

In case Smart view is not running – please start it.

If device data has not been loaded yet – click »Receive Data From The Device« in menu »Device«. 

Double click the »Operation« icon in the navigation tree.

Double click the »Recorders« icon in the navigation tree.

Double click the »Disturb rec-Icon«.

In the window the disturbance records are shown in tabular form.

In order to delete a disturbance record double click on:

(the red x) in front of the disturbance record and confirm.
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Smart View

Fault Recorder 

Read Out the Fault Recorder via Smart View 

In case Smart view is not running – please start it. 

If device data has not been loaded yet – click »Receive Data From The Device« in menu »Device«. 

Double click the »Operation« icon in the navigation tree.

Double click the »Fault Rec« icon within the tree »Operation/Recorders«.

In the window the fault recordings are shown in tabular form. 

In order to receive more detailed information on a fault double click the selected item in the list.

Via the print menu you can export the data into a file. Please proceed as 
follows:

Call up the data as described above.

Press the »Export to File« button.

Enter a file name.

Choose a location where to save the file.

Confirm the »Save« button.
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Smart View

Trend Recorder

Functional Description

The Trend Data are data points stored by the Trend Recorder on the relay device over fixed intervals of time, and 
can be downloaded from the device using Smart view.  A Trend Record is viewable using the Data Visualizer 
software by selecting files saved by Smart view with a file extension of “. HptTr”.  The list of available trend recorder 
data is viewable by selecting [Operation/ Recorders/Trend Recorder].

When viewed within the Data Visualizer, the trend record will show the observed values (up to 10) that the User has 
specified.  The values available in the Trend Recorder depend on the type of the connected device and the 
configuration of the Trend Recorder.

Managing Trend Records

To download information from the Trend Recorder, select [Operation/Recorder/Trend Rec] from the menu tree.  The 
User will find three options within the Trend Recorder window that will allow the User to:

Receive Trend Records,

Refresh the Trend Recorder, and 

Delete Trend Records.

Selecting the »Receive Trend Record« button will download data from the relay to the User's PC.  By selecting the 
»Refresh Trend Recorder«”, Smart view updates the list of the Trend Recorder.  The »Delete Trend Records« 
function will clear all trend data from the relay. Trend Recorder data previously stored on the User's PC remains 
untouched.

After having received trend data from the device, the User can view the data in the Data Visualizer by double-
clicking on the received “.HptTr” file stored on the PC. Once the “.HptTr” file is open, the User will see the “Analog 
Channels” that are monitored by the Trend Recorder.  By clicking on the “Analog Channels”, all monitored 
parameters are listed.  To view a channel, the User must click on the left mouse key, then drag and drop the 
channel onto the right side of the Data Visualizer screen.  The channel is then listed under the »Displayed 
Channels«.

To remove a channel from view, the User must select the Trend Data to be removed in the »Displayed Channels« 
menu tree, then click on the right mouse button to bring up the menu options.  Here, the User will find the 
»Remove« menu option that, when selected, will remove the trend data.
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Smart View

Event Recorder 

Read Out the Event Recorder via Smart View

In case Smart view is not running – please start it.

If device data has not been loaded yet – click »Receive Data From The Device« in menu »Device. 

Double click the »Operation« icon in the navigation tree. 

Double click the »Event Rec« icon within the »OPERATION/RECORDERS« menu. 

In the window the events are shown in tabular form.

To have the event recorder up-dated in a cyclic manner, select »Automatic Up-
Date« in menu View. 

Smart view is able to record more events than the device itself, if the window of 
the event recorder is opened and »Automatic Up-Date« is set to active.

Via the print menu you can export the data into a file. Please proceed as 
follows:

Call up the data as described above.

Call up the menu [File/Print].

Choose »Print Actual Working Window« within the popup.

Press the »Print« button.

Press the »Export to File« button.

Enter a file name.

Choose a location where to save the file.

Confirm the »Save« button.
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Smart View

Check Self-Supervision Messages via Smart view

This feature is available only when connecting with a recent HighPROTEC 
protection device (as of version 3.4).

The protection device supervises its own functionality by constantly performing various self-tests. If it detects any 
serious problem, or any event that has a serious impact on the operation of the device then this event is recorded.

The menu [Operation / Self Supervision / Messages] gives access to this list of internal messages. The following 
data is part of each entry:

• Record Number – a counter without special meaning

• Date of Record – timestamp of the event

• Message – a message ID with a (short, heavily abbreviated) message text

• Value – additional data specific to the event

All messages that can potentially appear here are described in detail in a separate document, the “HighPROTEC 
Troubleshooting Guide” (DOK-HB-TS).
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Smart View

Parameters

Changing Passwords via Smart view

Download the parameter file from the device.

Passwords can be changed by a double-click within menu [Device Para\Password\Change Password] on the 
corresponding password. 

Enter the old password and the new password twice

Confirm the changes by a click on »OK«.

Parameter Setting via Smart view

Smart view shows within the windows, where parameters are edited also the required access level for the 
parameters and settings. The required access authorizations will be verified when the parameter file should be 
transferred into the protective device. For the transmission, two options are available.

1. The transfer of all Parameters. This always requires the Supervisor (administrator) password.

2. The transfer of the modified Parameters only. It has to be taken into account, the passwords that are 
required by this are determined by those parameters, that require the highest passwords (access 
authorizations). 

Example1:
A »Prot-Lv1«-parameter and a »Prot-Lv2« parameter have been edited and should be transferred. The 
User will be asked for the »Prot-Lv2« password.

Example2:
A »Prot-Lv1« parameter and a »Prot-Lv2« parameter and a device planning parameter have been changed 
and should be transferred. The User will be asked for the »Supervisor-Lv3« password.

Example3:
A »Prot-Lv1« parameter and a »Prot-Lv2« parameter as well as a »Ctrl-Lv2« parameter have been 
changed and should be transferred. The User will be asked for the »Prot-Lv2« and the »Ctrl-Lv2« 
password.
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Smart View

Changing of Parameters when using the Smart View - Example

Example: Changing of a protective parameter (to alter the characteristic for the overcurrent protection function I[1] in 
parameter set 1).

In case Smart view is not in operation – start this software.

In case the device data has not been loaded – select »Data To Be Received From The Device« in menu 
»Device«.

Double-click the »Protection Para Icon« in the navigation tree.

Double-click the »Protection Para Set Icon« in the navigation tree. 

Double-click the »Set 1 Icon« in the navigation tree.

Double-click the »protection stage I[1]« in the navigation tree.

In the working window a tabulated overview appears, showing the parameters assigned to this protective 
function.

In this table double-click the value/parameter you want to change (here: »Char«).

Another window (popup) is opened where you can select the required characteristic. 

Close this window by clicking the »OK« key. 

A star symbol in front of the changed parameters indicates that the alterations 
have only been saved temporarily. They are not yet finally stored and adopted 
by the software/device.
In order to make things easier to follow, especially where complex parameter 
changes are involved, on every superior/higher menu level, the intended 
change of the parameter is indicated by the star symbol (star trace). This 
makes it possible to control or follow up from the main menu level at any time 
where parameter changes have been made and have not been saved finally. 

Plausibility check: In order to prevent obvious wrong settings the software 
monitors constantly all temporary saved parameter changes. If it detects an 
implausibility, this is indicated by a question mark in front of the respective 
parameter. 

In order to make things easier to follow up, especially where complex 
parameter changes are involved, on every superior/higher menu level above of 
the temporary saved parameters, an implausibility is indicated by a question 
mark (plausibility trace). This makes it possible to control or follow from the 
main menu level at any time where implausibilities exist.

So it is possible to see from each point of the menu tree that implausibilities 
have been detected by the software. 

A star/parameter change indication is always overwritten by the question 
mark/implausibility symbol. 

If the software detects an implausibility it rejects saving and adopting of the 
parameters. 
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Additional parameters can be changed if required.

There are two options available to transfer changed parameters into the device within menu »Device«.
 1.  »Transfer all Parameters into the Device«. This always requires the Supervisor (administrator) password.
2.  »Transfer only modified parameters into the Device«. For this parameter transfer the User needs passwords 
that provide sufficient access authorization for all parameters that are to be transferred. 

Confirm the safety inquiry »Shall The Parameters Be Overwritten?«.

Enter the password for setting parameters in the popup window.

Confirm the inquiry »Shall The Data Be Saved Locally?« with »Yes« (recommended). Select a suitable 
storing location on your hard disk. 

Confirm the chosen storing location by clicking »Save«. 

The changed parameter data is saved now in the data file chosen by you. Thereafter the changed data is 
transferred to the device and adopted.

Once you have entered the parameter setting password, Smart view wont ask 
you again for the password for 10 minutes at least. This time interval will start  
again, each time parameters are transmitted into the device. If for more than 10 
minutes no parameters are transmitted into the device, Smart view will ask you 
again for the password, when you are trying to transmit parameters into the 
device.
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Setting Groups

Setting Group Switch via Smart view

In case Smart view is not running – please start it.

If device data has not been loaded yet – click »Receive Data From The Device« in menu »Device«. 

Double click the »Protection Para« icon in the navigation tree.

Double click the »P-Set Switch« within the protection parameters.

Configure the Setting Group Switch respectively choose an active set manually.
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Copying Setting Groups (Parameter Sets) via Smart view

Setting groups can only be copied if there are no implausibilities (no red 
question mark).

It is not necessary to set up two setting groups that only differ in a few parameters.

With the help of „Smart view“ you can copy simply an existing setting group to another one(not yet configured) . You 
only need to change those parameters where the two setting groups are different.

To establish efficiently a second parameter set where only a few parameters are different, proceed as follows: 

In case Smart view is not running – please start it.

Open an (offline) parameter file of a device or load data of a connected device.

By way of precaution, save (the relevant) device parameters [File\Save as].

Select »Copy Parameter Sets« out of the menu “Edit”. 

Then define both, source and destination of the parameter set that should be copied (source = copy from; 
destination: copy to ).

Mouse click on »OK« to start copy procedure.

The copied parameter set is cached now (not yet saved!).

Then, modify the copied parameter set(s), if applicable.

Assign a new file name to the revised device parameter file and save it on your hard disk (backup copy).

To transfer the modified parameters back to the device, click on menu item »Device« and select »Transfer All 
Parameters into the Device«. 
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Comparing Setting Groups via Smart View

In case Smart view is not running – please start it.

Click on menu item »Edit« and select »Compare Parameter Sets«.

Select the two parameter sets from the (two) drop down menus you would like to have compared with each 
other.

Press the push-button »compare«.

The values that are different from the set parameters will be listed in tabular form.

Comparing Parameter Files via Smart view

With the help of „Smart view“ you can simply compare/diff the currently open parameter/device file against a file on 
your hard disk. The precondition is that the versions and type of devices match. Please proceed as follows:

Click on »Compare with a Parameter File« within the menu »Device«. 

Click on the Folder icon in order to select a file on your hard disk.

The differences will be shown in tabular form.
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Converting Parameter Files via Smart view

Parameter files of the same type can be converted. As many parameters as possible will be taken over.

Parameters, that are added newly will be set to default.

Parameters, that are not included in the target file version will be deleted.

In order to convert a parameter file please proceed as follows:

In case Smart view is not in operation – start this software.

Open a parameter file or load the parameters from a device that should be converted.

Make a backup of this file at a fail safe place.

Choose »Save as« from menu »File«

Enter a new file name (in order to prevent overwriting the original file)

Choose the new file type from drop down menu »File Type«.

Confirm the security check by clicking on »yes« if and only you are sure that the file conversion should be 
executed.

In tabular form the modifications will be shown as follows.

Added parameter:

Deleted parameter:
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Device Parameters

Assignment of Digital Inputs

There are two options available in order to determine where a Digital Input should be assigned to.

Option 1 -  Assigning a Digital Input onto one or multiple modules.

Adding an assignment via Smart view:
Within menu [Device Parameter\Digital Inputs] Digital Inputs can be assigned onto one or multiple targets. 
Call up the Digital Input (double click on the DI) and select the assignment that has to be added.
By means of clicking on »add« the assignment will be shifted from the list of available to the list of used 
assignments.

Deleting an assignment: via Smart view:
Call up the assignments (double click on the DI within the Software) and select the assignment that is to be 
deleted. The assignment will be deleted from the list of used assignments by means of clicking on »remove« 

Option 2 – Connecting a Module Input with a Digital Input

Call a module. Within this module assign a Digital Input onto a module input. Example: A protection module 
should be blocked depending on the state of a Digital Input.. For this assign onto the blocking input within the 
Global Parameters the Digital Input (e.g. Ex Blo 1). 
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Checking the Assignments of a Digital Input

In order to check the targets that a Digital Input is assigned to please proceed as follows:

Call up menu [Device Parameter\Digital Inputs]. 

Navigate to the Digital Input that should be checked.

Via Smart view

All targets of a Digital Input will be shown, listed and separated by a semicolon behind a Digital Input. Please note 
that the window might be to small and thus hide some targets. All assignments can be seen by means of a double 
click onto a Digital Input. Within this window also further assignments  can be done.

Synchronize Date and Time via Smart View

In case Smart view is not running – please start it.

If device data has not been loaded yet – click »Receive Data From The Device« in menu »Device« 

In the device tree, navigate to the entry »Date and Time«, which is in the menu branch [Device parameters / 
Time], and double-click this entry.

A dialog opens that show the current date and time of both PC and HighPROTEC device. (A checkbox 
allows to toggle the timezone between local and UTC; however, see also the note below.)

Click on the button “Synchronize”. You will be asked for the password of access level “Supervisor-Lv3”.

The HighPROTEC device receives and takes over date and time from the PC.

Smart view  as of version 4.50 in connection with a HighPROTEC device as of 
version 3.4 is able to consider that the timezone settings might be different on 
PC and HighPROTEC device.  

This is not possible in case of a connection with an older HighPROTEC device, 
so that there is the risk of ending up with a wrong time setting. Therefore it is 
recommended in case of an older HighPROTEC device to first set the device to 
the same timezone as the PC and only afterwards synchronize date and time.

If you are unsure whether your connection supports this timezone check: If the 
checkbox for toggling between UTC and local timezone is visible in the dialog 
mentioned above then the timezone check is supported.

Version via Smart view

Within this menu »File/Properties« you can obtain detailed information on the currently opened file like e.g. soft- and 
hardware version....

In order to be able to transmit a parameter file (e.g.: created off line) into the 
device, the following parameters must agree:

Type Code (written on the top of the device/type label); and

Version of the device model (can be found in the 
»Device Parameters\Version« menu).
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Display of ANSI-Codes

In order to display ANSI codes within the operation software please proceed as follows:

In case Smart view is not running – please start it.

Set set the checkbox - click »Display ANSI device numbers« within the menu »Settings« 

Graphical Display of Tripping Characteristics

The application supports the graphical display of tripping characteristics. Depending on the device type and the 
device configuration various tripping characteristics and related characteristics can be displayed.

Overcurrent Tripping Characteristics (ANSI, IEC,...)

LVRT/FRT Profiles (Low Voltage Ride Through)

Tripping areas of the underexcitation protection

Switchgear-Wear-Curves

Example – Graphical Visualization of the Overcurrent Tripping Characteristic I[1]

If the device data/parameters are not loaded yet, please load them from the device or open a file.
Navigate within the device parameter tree into menu [Protection Para / Set 1 / I-Prot / I[1]].
Double-click on element I[1].
The window that pops up will show all those parameters in tabular form that are tied to this protective element 
and that define among others the tripping characteristic.
Click on the icon »View Characteristic« within the command line of the window.

An additional window will show now the graphical visualization of the selected tripping characteristic.
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Adding and removing tripping characteristics to the visualization

Additional tripping characteristics of further protective elements and protection sets can be added to the 
visualization.

Example: Adding additional Curves to the Visualization of the Tripping Characteristic I[1]
Open, as described in the example above, the window for the visualization of the tripping characteristic of the 
protective element I[1].
Click within the menu bar of this working window on the icon »Add/Remove Curves...«

A selection window pops up. Select please:
• Which protective elements should be displayed additionally.

(Only available, if more than one protective element of the same type is projected.)
• Which parameter sets should be shown additionally in this visualization. 

(Only available, if this protective element is available in multiple parameter sets.)
Select those curves, that should be shown in addition to the current visualization.
Close the selection window by a click on »Apply«.
The graphical visualization is now being updated. And the additionally selected curves will be shown. 
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Selection of related curves

Related curves (e.g. reset curves, voltage restrained overcurrent curves,...) can be displayed, the availability is 
depending on the device and configuration.

Example: Visualization of the Reset Curve for Overcurrent Element I[1]

Open as described in the example above, the working window for the visualization of the tripping characteristic 
of the overcurrent element I[1].

There is a drop down menu within the the upper menu bar of this working window. This can be used in order to 
select related curves as:

• Tripping characteristics

• Reset curves

• Voltage restrained overcurrent protection curves

Select within the drop down menu »Reset curve«

The the working window will be updated. Now the »Reset Curve« will be shown instead of the »Tripping Curve«.
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Programmable Logic

Programmable Logic via Smart view

Improper use of Logic Equations might result in personal injury or damage the 
electrical equipment.

Don't use Logic Equations unless that you can ensure the safe functionality.

It is recommended to configure the logic via Smart view. 

How to configure a Logic Equation?

Call up menu [Logics/LE [x]:

Call up the Logic Editor

Set the Input Signals (where necessary, invert them). 

If required, configure the timer (»On delay« and »Off delay«).

If the latched output signal is used assign a reset signal to the reset input.

Within the »status display«, the user can check the status of the logical inputs and outputs of the Logic Equation.

In case that Logic Equations should be cascaded the user has to be aware of timing delays (cycles) in case of 
descending sequences (Please refer to section: Cascading Logical Outputs).

By means the Status Display [Operation/Status Display] the logical states can be verified.]
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IEC61850*

*=only available in devices that offer this protocol.

Generation/Export of a device specific ICD file

Each device of the HighPROTEC line includes a description of it's own functionality and communications skills in 
form of an *.ICD file (IED Capability Description).  This file can be exported as follows and be used for the 
configuration of the substation.

• A change of the devices parameters has an influence on the content of 
the ICD file.

1. Connect the device with your PC/Notebook.
2. Start Smart view.
3. Click on »Receive data from Device« in the menu »Device«.
4. Click on »IEC61850« in the menu »Device Para«.
5. Click on the ICD icon in the IEC61850 window.
6. Select a drive and file name for the ICD file and click "save".
7. Repeat the steps 1 to 6 for all connected devices in this IEC61850 environment.

Generation/Export of a SCD file

Each device of the HighPROTEC can create an export it's own functionality and communications skills in form of a 
*.SCD file.

1. Connect the device with your PC/Notebook.
2. Start Smart view.
3. Click on »Receive data from Device« in the menu »Device«.
4. Click on »IEC61850« in the menu »Device Para«.
5. Click on the SCD icon in the IEC61850 window.
6. Select a drive and file name for the SCD file and click "save".
7. Repeat the steps 1 to 6 for all connected devices in this IEC61850 environment. 
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Import of the .SCD file into the device

When the substation configuration is completed, the .SCD file has to be transmitted to all connected devices.  This 
is has to be done as follows:

1. Connect the device with your PC/Notebook.
2. Start Smart view.
3. Click on »Receive data from Device« in the menu »Device«.
4. Click on »IEC61850« in the menu »Device Para«.
5. Switch the parameter »IEC61850 Communication« to »OFF« and submit the changed parameter set into 

the device.
6. Click on the IEC icon in the IEC61850 window.
7. Select the folder, where the .SCD file is stored.  Select the .SCD file and click "open".
8. The file will now be checked.
9. The configuration can now be transmitted into the device if no internal fault can be detected. Press button 

”Send config”.
10. Now a password is requested.  Enter the same password, which you use for parameter setting of the 

device.
11. Acc. to step 5 switch on again the IEC Communication and submit the changed parameter set into the 

device.
12. Repeat the steps 1 to 11 for all devices connected to this IEC61850 environment.
13. If no error message occurs, the configuration has been completed successfully.

• When changing the substation configuration, usually a new .SCD file 
has to be generated.  This .SCD file has to be mandatory transmitted to 
all devices by means of Smart view.  For the case, that this step will be 
forgotten, IEC61850 malfunctions will be the result

• Provided that parameters of the devices are changed after the 
substation configuration completion, changes in the corresponding .ICD 
file may result – this in turn may make an update of the .SCD file 
necessary.
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Remote Configuration for Line Differential Protection Devices*

*=only available in HighPROTEC devices with Line Differential Protection.

In case of two interconnected Line Differential Protection devices, Smart view also allows the configuration of the 
remote device.

The “remote access” feature of the local Line Differential Protection device has 
to be set to active. 

The communication with the remote device uses the TCP/IP port 52160; 
therefore this port must not be blocked by a firewall.

1. Connect the local device with your PC/Notebook.
2. Start Smart view.
3. Click on »Receive data from Device« in the menu »Device«.
4. After the connection is established a selection window for the local or remote device appears.
5. In this selection window choose »Remote Device«.
6. The data of the remote device will be loaded.

The device data tree in Smart view is marked with a yellow frame whenever data of the remote device is displayed.
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